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Help & Support

First please read this manual thoroughly (particularly the Troubleshooting section, if present). 

Tritech International Ltd can be contacted as follows:

Mail Tritech International Ltd
Peregrine Road
Westhill Business Park
Westhill, Aberdeenshire
AB32 6JL, UK

Telephone ++44(0)1224 744 111

Fax ++44(0)1224 741 771

Email support@tritech.co.uk

Website www.tritech.co.uk

Prior to contacting Tritech International Ltd please ensure that the following is available:

1. The  Serial  Numbers  of  the  product  and  any  Tritech  International  Ltd  equipment
connected directly or indirectly to it.

2. Software or firmware revision numbers.

3. A clear fault description.

4. Details of any remedial action implemented.

Contamination
If the product has been used in a contaminated or hazardous environment you must
de-contaminate the product and report any hazards  prior  to returning the unit for
repair. Under no circumstances should a product be returned that is contaminated
with radioactive material.

The  name  of  the  organisation  which  purchased  the  system  is  held  on  record  at  Tritech
International  Ltd  and details  of new software or hardware packages will  be announced at
regular  intervals.  This  manual  may not  detail  every aspect  of  operation and for  the latest
revision of the manual please refer to  www.tritech.co.uk Tritech International Ltd  can only
undertake to provide software support of systems loaded with the software in accordance with
the  instructions  given  in  this  manual.  It  is  the  customer's  responsibility  to  ensure  the
compatibility of any other package they choose to use.
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Warning Symbols

Throughout this manual the following symbols may be used where applicable to denote any
particular hazards or areas which should be given special attention:

Note

This symbol highlights anything which would be of particular interest to the reader 
or provides extra information outside of the current topic.

Important

When this is shown there is potential to cause harm to the device due to static 
discharge. The components should not be handled without appropriate protection to
prevent such a discharge occurring.

Caution

This highlights areas where extra care is needed to ensure that certain delicate 
components are not damaged.

Warning

DANGER OF INJURY TO SELF OR OTHERS 

Where this symbol is present there is a serious risk of injury or loss of life. Care 
should be taken to follow the instructions correctly and also conduct a separate 
Risk Assessment prior to commencing work.
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1. Hammerhead Sonar Specification

1.1. Dimensions

1.2. Acoustic

Operating frequency 675kHz 935kHz

Beamwidth 30° vertical, 0.9° horizontal 20° vertical, 0.6° horizontal

Maximum range 100m 40m

Minimum range 0.4m

Range resolution approximately 7.5mm

1.3. Sonar Display

Range selections 2m to 100m

Scan resolutions 0.225°, 0.45°, 0.9°, 1.8°

Continuous 360° Yes

Offset sector scan Yes

Attitude information Angle of sonar body to vertical (2 axes)

Heading information Sonar heading with transducer in straight ahead position
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1.4. Electrical and Communication

Operating voltage 20 – 72V DC

Power requirement 30W

Communication protocol RS232, RS485, ARCNET

Connector options Tritech 6-pin standard (others available on request)

1.5. Physical

Weight in air 6.8kg

Weight in water 3.8kg

Depth rating 700m standard
4000m optional

Materials Aluminium alloy (hard anodised)

Operating temperature -10 to 35°C

Storage temperature -20 to 50°C
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2. Hammerhead Interface Box Specification

2.1. Dimensions

2.2. Physical

Weight 2.74kg

IP67 Rating The Interface Box is sealed against dust and moisture ingress to IP67 standard

2.3. Electrical and Communication

Ports AC Power, DC Power, USB PC connection, Sonar connection

DC Power draw (idle) 3VA

DC Power draw (load) 42VA

AC Power draw (idle) 17W at 240V AC

AC Power draw (load) 46W at 240V AC

DC Input Voltage 12 – 36V

AC Input Voltage 100 – 240V (50 – 60Hz)

Warning

If operating on 240V AC mains supply (or equivalent from a generator) the 
Interface Box must not be exposed to water.
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3. Hammerhead Cable Reel Specification

Weight of 100m reel ~13kg

Weight of 150m reel ~16kg

Weight of 200m reel ~20kg

Weight of reel approximately 6kg unladen

Weight of cable approximately 0.07kg per metre

Material Yellow Polyurethane Aramid (Kevlar) fibre braid

Material thickness 1.4mm (nominal)

Cable diameter 7mm (nominal)
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4. Hammerhead Tripod Specification

Dimensions are in millimetres

Weight of tripod in air ~9.6kg

Weight of tripod in water ~8.4kg

Material Stainless Steel

0672-SOM-00001, Issue: 04 Page 12 of 90 © Tritech International Ltd.



SeaKing Site Survey System

5. MicronNav Transponder Specification (Optional)

5.1. Dimensions

5.2. Physical Properties

Weight in air 225g

Weight in water 70g

Depth Rating 750m

5.3. Acoustic Properties

Beamwidth Omni-directional

Transmitter Source 169dB re 1μPa at 1m

5.4. Electrical and Communication

Power requirement 12 – 48V DC

Power consumption 3.5W transmitting, 0.28W standby

Data communications RS232 or RS485
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6. Hardware Installation

If the unit has been bought with the optional tripod arrangement it will come supplied with all
the  necessary fittings  to  enable  the Hammerhead unit  to  be mounted.  For  a  guide on the
assembly of the tripod unit please see Appendix B. Assembly of Hammerhead Tripod

The Hammerhead is supplied with a waterblock and connector with a length of  polyurethane
jacketed  cable.  If  an alternative  connector  is  utilised,  a  cable  may not  be  supplied  and a
suitable connector will need to be obtained separately for system integration.

The waterblock is  fastened to  the connector  endcap and provides  a  4000m rated pressure
bulkhead. This will protect the electronics from water ingress in case the connector is damaged
or  not  fitted  correctly.  It  is  not  necessary  to  remove  the  waterblock  when  removing  the
connector.  Whenever  the connector  is  removed,  blanking plugs  should be used to  prevent
ingress of dirt or moisture to the waterblock.

For mounting on an ROV the head should be secured by clamping on the cylindrical body
section such that  the  transducer  head is  unimpeded and unshielded.  The clamp should  be
applied centrally to the metal body tube and should not be over-tightened.

Caution

It is recommended that a substantial guard is fitted to the ROV over the scanning
head  to  protect  from impact  damage.  Care  should  also  be  taken  to  ensure  the
transducer head can rotate freely and will not be snagged by any trailing cables.
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7. Mounting

7.1. Optimal Orientation

If using with the Tritech International Ltd tripod arrangement the unit is self-levelling to a
maximum of 15°. Ensure that the Hammerhead is mounted with the transducer at the bottom.

For ROV installation always mount the Hammerhead so that it is as close to the true vertical as
possible in relation to the trim position of the vehicle. The front filling plug and red LED
should be aligned with the natural direction of travel of the vehicle. 

Errors in the head alignment can give rise to unreliable results.

7.2. Mounting Material and Suitable Brackets

Caution

Avoid any metal alloys containing copper such as brass or bronze.

Non-metallic clamps should always be used where possible to prolong the life of the unit and
prevent any galvanic corrosion effects. If metallic clamps are used they should be electrically
insulated from the sonar body by means of rubber or plastic strips or mount brackets of at least
3mm thickness and extending at least 3mm beyond the clamp boundary. They should also be
painted or lacquered with at least three coatings.
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8. Electrical and Communication

8.1. Power Requirement

The Hammerhead unit will typically draw 30W of power and requires a regulated DC volrage
supply of between 20 and 72V.  The optional Hammerhead Interface Box also provides power
to the unit as well as a communication link.

Caution

Do not attempt to run at higher voltages to compensate for longer cable lengths. 
This will also increase the current and potentially damage the sonar head.

8.2. Communication Link

The Hammerhead is normally connected using an RS485 serial link which can be achieved by
connecting  to  the  serial  port  of  an  SCU,  using  an  RS485 to  USB converter  or  using  the
optional Hammerhead Interface Box which will provide a USB output to the PC or laptop.

As a single device the Hammerhead will communicate with AutoComms technology which is
an automatic setup so there is no requirement to dismantle the unit or manually set any of the
communications  settings.  Set  the  desired  communications  protocols  in  software  and  the
Hammerhead unit will automatically update itself to match.

Note

The AutoComms feature will only work with newer versions of Seanet Pro, so 
make sure you have the latest version installed.

For AutoComms to function the correct wiring must first be in place and connected 
prior to applying power.

8.3. Networking

Note

To  network  the  devices,  AutoComms  will  have  to  be  disabled  and  the
communications settings manually selected. Please see the Appendix F. Networking
and Communication or more information.
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The Hammerhead may form part of a network of sensors using the ARCNET protocol. This
would normally be interfaced through a Surface Control Unit (SCU) or using a SeaHub device
(for  detailed  setup  information  please  refer  to  the  appropriate  SCU  or  SeaHub  manual).
Normal communication with the sonar head requires a good quality balanced twisted pair
cable.

For mounting on an ROV an optional 4000m pressure rated junction box is also available to
provide an RS232 interface to the network of Hammerhead or SeaKing ARCNET devices.
Please contact Tritech International Ltd customer support or visit www.tritech.co.uk for details
of the sub-sea junction box.

8.4. Waterblock Pin-out Diagram

Tritech Waterblock

Pin MAIN Port AUX Port Cable colour

1 RS232 TX
ARCNET A

RS485 A

RS232 RX
ARCNET A

RS485 A

Yellow

2 RS232 RX
ARCNET B

RS485 B

RS232 TX
ARCNET B

RS485 B

Blue

3 +DC Power Red

4 -DC Power Black

5 Dual Head Sync/RS232
Ground

Green

6 Earth/cable shield cable screen

8.5. Cable Termination and Limits

Note

Termination resistors  are  only required for  ARCNET communication – a  single
Hammerhead unit operating on the standard RS485 serial protocol will not need
any  termination  resistors  fitted.  For  detailed  ARCNET  setup  information  see
Appendix E.  ARCNET Termination
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9. Software Installation

Note

For the latest version of the Tritech International Ltd software packages please visit
www.tritech.co.uk 

The Seanet  Pro  software  will  be  provided either  on  an  installation  CD (for  Hammerhead
Interface Box to PC) or pre-installed on the Seanet SCU.

For the CD installation, if Setup does not automatically start on disk insertion, run the run.exe
file from the disk to start the installation. If you need to reinstall the software, this can be
accomplished through the normal Windows software removal application.

From the installation main screen it is possible to select the installation of either the Seanet Pro
software or the Sonar Image Tiler application. 

For more information on installation and operation of the software please see the Seanet Pro
Software Manual which is available from www.tritech.co.uk and is pre-installed with Seanet
Pro as the interactive "help" feature.
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10. Prior to Deployment

On completion of the installation of the sonar,  it  can be tested in air  by powering up the
system, entering the "Single Sonar" application of Seanet Pro and observing that the red LED
flashes once per revolution of the transducer as it passes the straight ahead position.

Connection to the computer which is to be used should enable confirmation that the signal is
being sent and received as desired, however, until the unit is submerged the sonar display will
be meaningless.

Bench Testing

If testing the Hammerhead in air prior to use it is recommended to utilise the tripod to support
the unit while undertaking the test. Alternatively, if testing on a bench or worktop it is essential
that the transducer head is free to rotate.

The Hammerhead should be placed as follows:
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11. Deployment

If  using  the  tripod  arrangement  for  deploying over  the  side  of  a  vessel  or  dockside  it  is
important  to  check  that  the  path  into  the  water  is  clear  and  free  from obstacles  prior  to
lowering over the side. Care should also be taken to ensure that sufficient cable length is
available and that there are  no snags in  the cable.  If  a  Kevlar reinforced cable and arrest
system has been purchased then the device can be raised/lowered using the cable, however, it
is recommended that a rope or chain is used to prevent the possibility of damage from the
cable snapping.

Warning

A minimum  of  two  people  should  be  employed  to  deploy  and  retrieve  the
Hammerhead and tripod and both should be equipped with life-vests.

Step 1

Two people  should  bring  the  tripod  to
the  waters  edge,  holding  the  legs
securely

  
Step 2

Lower the legs over the side of the boat
or dock until the rope at the top is easy
to grasp.

  
Step 3

Take a firm grasp of the rope and lower
the rest  of the way into the water – at
this  point  the  second  person  is  not
required for lowering and should instead
ensure that the rope is free to run.

  

0672-SOM-00001, Issue: 04 Page 20 of 90 © Tritech International Ltd.



SeaKing Site Survey System

Caution

Do  not  attempt  to  lower  the  tripod  using  the  data  cable  unless  it  is  Kevlar
reinforced  and  fitted  with  an  arrest  system,  otherwise  it  could  break  or  cause
damage to the waterblock or connector. If in doubt use a rope attached to the tripod.

Once the tripod has been lowered into the water it is important to ensure that the device is
sitting level, while small variations in the seabed can be corrected by the gimbal arrangement
of the tripod, any variation greater than 15° in any direction will result in incorrect images on
the sonar display. Attitude can be checked using the built-in sensor which is displayed on the
main Seanet Pro screen.

Tripod not level and
beyond the 15° range of
the gimbal – will result

in incorrect images
and will have to be

moved to a new location.

Tripod not level but
Hammerhead has

self-levelled due to
the gimbal feature.

The perfect scenario
where tripod is lowered

onto a level seabed.
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12. Retrieval

On retrieval of the system it may become snagged with ropes, seaweed or other debris as it is
being drawn out of the water. It is advisable to have a boat-hook or other device available to
free the tripod legs and enable easy retrieval.

The tripod legs are likely to catch and
drag on harbour side so any chains,
etc., will be caught on the leg – free 
these with a boat-hook or similar to

prevent excess weight on retrieval rope

The  unit  should  then  be  washed  down  and  stored  in  accordance  to  the  instructions  in
22. Maintenance of the Hardware 
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13. The MicronNav Transponder

13.1. Overview

The MicronNav Transponder is an optional part of the system that is purchased separately as a
part of the MicronNav System. Please contact Tritech International Ltd for more details and
refer to the MicronNav System manual for a complete guide on the installation and set up of
the MicronNav equipment.

This section details only those aspects of operation and installation that are specific to the
SeaKing Survey System and for the sake of brevity it is necessary to leave out many details.
Any information which is missing from this manual will be captured in other documents, all of
which are available from www.tritech.co.uk.

13.2.  Transponder Installation on Tripod

The MicronNav Transponder is designed to fit into a black acetal housing which is screwed
onto the Hammerhead tripod, this housing is normally supplied with the tripod.

To attach the MicronNav mount first locate the correct hole on the top plate of the tripod. The
correct hole is the one which is away from the gimbal ring locking bolts.

Once the correct hole has been
located,  hold  the  bottom part
of  the  MicronNav  mount
underneath  the  tripod  top
plate.
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Next place  the  top  section  of
the MicronNav mount onto the
bottom  section  and  screw
down.

  

The  completed  installation  of
the  MicronNav  mount  should
look like this:

  

13.3. Electrical and Communications

In  Transponder  mode  the  MicronNav  subsea  modem  head  only  requires  power  supply
connections, all communications are achieved through the water.

A suitable connection cable is supplied with the system and is wired as follows:

MicronNav
Transponder cable end

Pin Wire
Colour

Function

1 Yellow n/c

2 Blue n/c

3 Red +V DC

4 Black 0V

5 Green n/c

6 none screen

n/c = not connected

Hammerhead AUX 
port cable end.
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13.4. Transponder Operation

Once the MicronNav Transducer is correctly installed on the top of the Hammerhead tripod it
will be necessary to configure the rest of the MicronNav System. It may also be necessary to
construct a suitable mounting arrangement for the MicronNav Dunking Transducer.

Full  details  of  the  correct  configuration  and  mounting  arrangements  can  be  found in  the
MicronNav System Manual (document reference 0656-SOM-00001).

Seanet Pro Application

If Seanet Pro has not been used with a Hammerhead and MicronNav before then it
will be necessary to set up a new Seanet Pro Application (“Applications” menu and
then select “Application Wizard”). 

The application should include a “Sonar” (for the Hammerhead) and “MicronNav”
(for the Transponder). Once this Application is set up it will be saved automatically
and subsequently can simply be selected from the “Applications” menu.
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14. Hammerhead Software Features

The Seanet Pro software is used to operate the Hammerhead system and a comprehensive
manual for the Seanet Pro software will have been supplied with the system (in electronic
format) and can also be found on the Tritech International Ltd website. SCU systems generally
have an electronic manual already installed by default.

One  unique  feature  of  the  Hammerhead  Sonar  is  that  it  is  supplied  with  two  operating
frequencies  of  675kHz and  935kHz –  the  frequency can  be  switched  by clicking  on  the
number in the main Seanet Pro display or by pressing the "Freq" button on the RAT (button
F5).

The default operation of the Hammerhead version of Seanet Pro software has other device
options  removed  from  the  “Applications”  menu  but  these  can  be  enabled  using  the
“Application Wizard”.  This  is  useful  if  the Hammerhead is  to be used with a  MicronNav
system or if  it  were used alongside other  Tritech International Ltd products like a PA500
altimeter on an ROV.

The Hammerhead device also has the ability to build up a picture of a wide area as a series of
"tiles" which are then stitched together in using the Tritech Sonar Image Tiler post-processing
software. 

Using the Hammerhead and MicronNav along with a  GPS device and Sonar  Image Tiler
software will enable positional recording and charting and can be used to create a detailed
record of wreck sites or harbours.

The Hammerhead also incorporates an attitude sensor and compass so these will be displayed
by default on the Seanet Pro main screen.

Note

A line  of  sight  has  to  be  maintained  between  the  MicronNav  Transducer  and
Transponder at all times and in particularly noisy environments such as confined or
busy harbours the acoustic positioning may be adversely affected.
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15. Seanet Setup

If a MicronNav System is installed

If a MicronNav Transponder is in use with the survey system it will be necessary to
set up Seanet Pro for use with a MicronNav System as well, so in addition to the
following  steps  to  set  up  for  a  single  Hammerhead  the  procedures  within  the
MicronNav  System  Manual  (document  reference:  0656-SOM-00001)  should  be
followed.

15.1. Outline of Procedure

To set up the Seanet Pro system for use with the Hammerhead the following basic procedure
should be followed (these points are expanded below):

1. Connect the Hammerhead Interface Box to the computer via USB (no external power
to the Interface Box is required at this point).

2. Obtain the COM port number which corresponds to the Interface Box.

3. Configure Seanet Setup to use the correct COM port number.

4. Connect the Hammerhead Sonar to the Interface Box.

5. Provide power to the Interface Box and turn on the Sonar Power switch.

6. Verify that the Hammerhead Sonar is displayed in Seanet Setup.

15.2. Connecting the Interface Box

If  using  a  single  Hammerhead  Sonar  and  the  Hammerhead  Interface  Box  and  a  default
installation of Seanet Pro it will only be necessary to enter Seanet Setup to select the correct
serial  COM  port  as  detected  by  the  computer.  The  number  of  this  COM  port  will  vary
depending on the individual computer and can be found by navigating to the Windows Control
Panel and then the Device Manager under which there is a drop-down list of COM ports called
“Ports (COM & LPT)”.

When  the  Hammerhead  Interface  Box is  connected  via  USB Windows will  automatically
assign a COM port to it. If there are several entries in the list the correct COM port can be
identified  by  monitoring  the  list  and  unplugging  the  Interface  Box,  at  which  point  the
corresponding port number will disappear from the list. The Interface Box will be listed as a
“USB Serial Port”.

Once the COM port number is known start Seanet Setup by clicking on the desktop icon or
through the Start menu. Navigate to the “Utilities” menu and select “Com Setup”.
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In the “Channel Setup” dialog which is now displayed find the entry labelled “Aif” (it is the
first entry by default) and click on the “Enabled” check box. Once the Aif device is enabled,
click on the right arrow in the “COM Port” column to advance the COM port to the correct
value  (in  the  example  below Windows assigned  COM21 to  the  Interface  Box).  Once  the
correct value is selected the Status column will turn green and be labelled “OK” and the Type
column will display “USB”.

15.3. Connecting the Hammerhead Sonar

Once the Interface Box is correctly configured the SeaKing Hammerhead Sonar should be
connected to the Interface Box and power should be provided through either the AC or DC
inputs on the rear of the Interface Box.

If the power supply is correct the Power Connected LED will illuminate on the top of the
Interface Box and it will now be possible to turn on the sonar by pressing the Sonar Power
button on the front.

After a short delay while the Hammerhead Sonar automatically configures itself to the correct
communications protocols the sonar head will be displayed in the Seanet Setup dialog box as
follows:

At this point Seanet Setup can be closed and the main Seanet Pro application can be started.
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16. Seanet Pro Main Functions

16.1. Main Screen

The Seanet Pro application can be run from the Programs group in the Windows Start menu or
from the desktop by double clicking on the shortcut icon.

 Display  Header  –  This  part  of  the  screen  is  used  for  system/software
identification

 Menu Bar – This is where system setup functions can be accessed.  Printing,
Application  selection,  Colour  Scheme  setup  and  Logging  are  some  of  the
features that can be accessed in this screen area.

 Settings Bar – This is where the sensor can be controlled and configured.  The
settings bar is on top of every display window for each device that is connected
to the system.  It includes a Tools Setup button, LED indicator (Pause/Go) and
RAT dials and buttons.

 Status Bar – This part of the screen is used to display system status information,
typically interface status, logging status/progress and job specific information

 Sensor Display Area – This part of the screen is where the main sensor data is
displayed.  Other pertinent data such as range scale, cursor and status messages
pertaining to the sensor may also be displayed within this area.

 Sidebar – This is where serial input data and custom text can be displayed.  This
bar can be placed on the left or right side and it can also be hidden.

0672-SOM-00001, Issue: 04 Page 29 of 90 © Tritech International Ltd.



SeaKing Site Survey System

16.2. Sonar Settings

These controls are displayed on the Sonar Settings bar. When the RAT is used or screen cursor
is moved over the Sonar Settings bar, a pop-up control panel will appear which will display the
remaining controls. These mimic the positions of the rotary controls (C1 to C5) and function
buttons (F1 to F7) on the RAT. Adjustments may be made using the RAT or the on screen
controls using the pointer device.

Note

F1 and F2 are not applicable in single window applications, F7 is not used.

Sonar Gain (C1) This sets the sonar receive gain as required – typically this is
around  50%  but  is  varied  according  to  water  and  target
conditions and user preference.

Contrast (C2) This  sets  the  display  contrast  between  hard  and  soft  targets.
Usually set to user preference, it can help find small features in
generally featureless situation or exclude clutter from a heavily
featured seabed.

Range (C3) This sets the maximum range the sonar will scan. Long ranges
are  scanned  more  slowly  than  short  ranges  due  to  the  limit
imposed by the velocity of sound in water.

Sector Scan Direction (C4) This is used to set the centre of the scanned sector particularly
useful  when using a  narrow sector  width to  concentrate  on a
particular feature.  A well  positioned, narrow sector will  allow
faster scan updates than a wide sector.

Sector Scan Width (C5) This sets the width of the scanned sector. Typically this will be
adjusted according to the required seabed coverage.

Display Sensitivity (C6) This  sets  the  display sensitivity threshold.  A low setting  will
effectively remove very low level returns from being displayed
which may include (soft) seabed backscatter whereas a higher
setting will start to remove higher amplitude echoes which may
include objects  of interest.  It  is  normal  to  keep this  at  a low
setting of no more than 5dB to remove low level ‘noise’.

CYC (F1) - Cycle Window This can be used when one of the display windows is maximised
using the Expand (F2) button and will cycle between the Sonar
display  windows.  Also  use  the  F1  button  to  switch  focus
between the display windows. The optional RAT controller will
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switch its control to the display that has the focus. Note: clicking
on a display with the mouse pointer will also switch focus to
that display.

EXP (F2) - Expand Window This will maximise the current display window that is in focus.
Either click on a display window to switch focus to it  before
expanding, or press the Cycle (F1) button to switch focus to a
display window.

ZOOM (F3) This will toggle the Acoustic Zoom window on/off. This draws a
zoom box on the display positioned by the cursor. This control is
also toggled via Application Tools – Acoustic Zoom. The Zoom
window size and magnification can then be adjusted in ‘Zoom
Setup’ in the Application Tools. RES (F4) – Sonar Resolution
Resolution  toggles  through  preset  step  sizes  for  the  sonar
scanning. Available step sizes is dependant on the sonar being
used. Smaller angles give a higher resolution picture but slower
scan speeds. Usually a Lo or Med resolution is used for tracking
moving targets and Hi or Ult for detailed examination of static
targets.

FREQ (F5) - Sonar 
Frequency

This toggles between the channels available on the sonar. For a
single frequency sonar unit this control will be inactive and will
lock to indicate the operating frequency of the sonar.

REV (F6) - Reverse Scan 
Direction

This allows the operator to instantly reverse the scan direction
without waiting to reach the end of the scanned sector.

Sector Quick Select This group of 5 buttons in the bottom right of the control allows
the user to make a quick selection of a full 360° scan or 180°
forward,  back,  left  or  right.  The  display  view  is  changed
automatically and the appropriate sector width and direction set.

16.3. Status Bar

 Date and time

 Status of interface card (AIF card)

 ARCNET LAN Timeout counter

 Status of Serial COM ports

 Status of Remote Access Terminal (RAT)

 Sensor Status

Various error codes are reported in the status bar at the bottom of the screen. These help the
user determine any faults with equipment or cabling, as a guide to making any corrections or
replacements.
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Status and Error Codes

No Aif The AIF card  is  not  installed  or  not  configured/enabled  correctly.
This  status  will  also  appear  when  using  the  SeaHub  serial  port
interface instead of the AIF card interface.

Rat Ok Remote  Access  Terminal  (RAT)  is  connected  and  communicating
okay.

Rat N/A RAT is not connected or there is a connection problem.

No COM Will display if only an AIF Card interface is in use or no COM Port
has yet been opened (e.g. No “Aif” device yet enabled from Com
Setup accessed through the Utilities menu).

Com OK For SeaHub or COM Port interface; A COM port has been opened
and is functioning correctly.

Com Bad For SeaHub or COM Port interface; The COM port cannot be opened
– it  may already be in  use by another  application or may have a
problem.

Com AIF Error TMO For  SeaHub  or  COM  Port  device  interface;  the  device  is  not
responding (check it is connected and powered).

Timeout x There is no communication with head node x

16.4. Main Menu

Print – output screenshot to printer

Screen – capture screen to AVI or save screen to Bitmap/Tiff

Exit – used to exit the program

Load/Save Settings – save and load the current display and 
device settings (up to 8 can be saved).

Environment – used to enter environmental parameters such as 
system Velocity of Sound

Always on Top – “Main Screen” is aways on top of windows 
desktop

This Menu Item will only be present in Seanet Pro and not from
running  Seanet  Setup  from  the  desktop  icon.  Application
examples include Single Sonar, Sonar Profiler and Sonar Bathy
Profiler. There is also an Application Wizard available at the top
of  the  list  which  can  be  used  to  create  user  applications  for
required device combinations.
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GPS –  Pop-up  form to  display  GPS  data  received  through  a
COM port.

Compass  –  Pop-up  Form  to  display  Compass  data  received
through a COM port.

Auxiliary Device – Pop-up Form to display Aux Device data (i.e.
Digiquartz  Pressure  Sensor  or  PA/NMEA  Altimeter  data)
received through a COM port.

Com Setup – Configure and Enable COM ports for various serial
inputs/devices  including  GPS,  Pipetracker,  Barometer  and
Compass.

GPS Diagnostic – Terminal for viewing received serial data.

Compass Diagnostic – Terminal for viewing received serial data.

Auxiliary Device Diagnostic – Terminal for received serial data.

Barometer Diagnostic – Terminal for viewing serial data.

Sidebar  –  Enable/Disable  the  Sidebar.  Note:  In  certain
applications, i.e. ‘Sonar Video’, the Sidebar will be opened and
docked to the blank ¼ window panel filler.

Toolbars – There are several toolbars containing shortcut buttons
which can be displayed in the Menu Bar area or docked to the
sides of the Display Area. For details see the "Toolbar Shortcut
Buttons" section.

Play – use to play back recorded log data.

Record – use to record Sonar data.

Stop – stop recording and/or Auto Logging.

Setup – select file options for recording log files.

Sonar (this will be renamed for other devices, e.g., “Sidescan”,
“Profiler” or “Bathy”).

Colours – use to select a saved colour scheme

Colour Setup – use to configure the existing colour scheme or
create a new colour scheme.
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Some examples of colour schemes that are available by default:

Windows (only functional in multi-Sensor Applications)

Cycle F1 – Cycle to the next Display Window (can also be done
using the F1 key).

Zoom  F2  –  Enlarge  the  current  Display  Window  to  fill  the
window, click again to display all the Display Windows (can also
be done with the F2 key).

Sonar – Switch focus to Sonar Display window.

Sidebar  – Will  be replaced with name of another  Sensor  in  a
Multi-Sensor Application.

The  Sound  menu  enables  an  acoustic  representation  of  the
visuals  presented  on  the  Main  Screen  of  the  Seanet  Pro
application. Clicking on Setup allows configuration of how this
sound is represented.

About Seanet – gives details of program and version numbered

Seanet Guide – Seanet help files

System Information – Gives information of computer resources

16.5. Measurement Tool

By  left  button  clicking  and  dragging  on  the  Sonar  display  window  (or  Acoustic  Zoom
window) an elastic band is laid for range and position measuring of targets.

Dx, Dy = Cartesian co-ordinates of current pointer position relative to Sonar.

Rng, Brg = Polar position of pointer relative to where elastic band was laid.

Note

The range units used are those selected in the Setup menu.
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16.6. Toolbar Shortcut Buttons

 Play Log File – Opens a dialog window to enable the selection of a V4Log file
for playback.

 Record Log – File Starts recording a log file, a dialog box will
present itself so a name can be chosen for the log file.

 Stop Logging/Playback – Halts the current playback or
recording activities.

 Log File Setup – Opens the settings dialog to control how files
are logged.

 Print – Opens the Print dialog to enable selection of an output
printer, paper size, etc.

 Printer Setup – Enables printer settings to be changed.

 Quick Print – If Quick Print is enabled when Print is selected the dialog box
will not appear and instead the printer will use whatever settings have been
specified in Printer Setup.

 Sidebar – Displays or hides the right-hand sidebar.

 Start Screen Capture to AVI – Starts recording an AVI file onto disk (note that
this does not include an associated log file).

 Stop Screen Capture Stops the recording activity.

 Screen Capture Settings – For changing the settings for the AVI recording.

 Snapshot – Opens a dialog prompting for a name for either a Bitmap (.bmp) or
TIFF (.tiff) image of the sonar screen.

Note

Right-clicking on a space within the button bar brings up a menu to enable different
types  of  buttons  to  be shown/hidden.  This  is  a  duplicate  of  the Toolbar  option
located in the View menu.

De-selecting Large Icons is useful if working on a low resolution display.
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16.7. Dynamic Range and Sonar Rx Indicator

The dynamic range bar is the A/D sample window (with 64-colour mapping) for the
Sonar receive signal (which extends from 0 to 80dB).

To the right of the dynamic range bar is the Sonar receive signal strength indicator
(Yellow = Average amplitude over  scan-line,  Red = Maximum amplitude echo for
scan-line).

Normally  the  sampling  window  should  not  need  to  be  adjusted  from  its  default
position  (as  shown  on  the  left).  However,  if  used  properly,  adjusting  the  sample
window can produce better quality imaging.

The  dynamic  range  bar  can  be  adjusted  to  change  Sonar  display  contrast  and
sensitivity. Adjustment is made using the left and right mouse buttons. 

Contrast adjustment Right-click on the bar and whilst holding down the right
button, move the mouse up/down to increase/decrease the
size  of  the bar.  The sampling  window can be any size
between a range of 9 – 25dB. Decrease the size of the
sampling window to increase the sonar display contrast.
Ideally the control should be set somewhere in the centre
of the allowed range (16 – 18dB) to give the best results
under most conditions. Select a high value to reduce the
contrast of the sonar display.

Sensitivity adjustment Left-click  on  the  bar  and whilst  holding down the  left
button, move the mouse up/ down to decrease/increase the
Sensitivity  of  the  Sonar  receiver.  Decreasing  the
Sensitivity  will  produce  a  more  saturated  display  with
greater  weak-return  content.  Increasing  the  Sensitivity
will omit background noise and low level returns seen at
the receiver

The sonar receiver will accept a return signal in the region of 0 – 80dB. The dynamic range
controls are used to adjust the position of a sampling window within the 0-80dB dynamic
range band of the receive signal. An idealised representation of the sample window is shown:
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16.8.  Colour Setup

This is accessed via “Colour Setup” which is found in the “Sonar” menu.

Note

For other device applications such as Profiler, Bathymetric or Sidescan, the Sonar 
menu item will be replaced with Profiler, Bathymetric, Sidescan as appropriate.

Click on the New button to start a new colour scheme or change the colours of the current
scheme (indicated in the drop-down list,  Colour6 in this  case).  There are 7 factory preset
colour schemes which cannot be altered. If you try to alter these schemes then a dialog will
prompt you to save to a new scheme if and when you try to save or apply changes.

The various colour boxes can be clicked on to configure a new colour for that item. The 3
slider bars are used to set the new RGB colour levels for each item and the Apply button is
used to confirm the changes. Clicking on OK accepts all changes and exits the dialog.

16.9. Environment Setup

This  is  accessed  by navigating  to  “Environment”  in  the  “Settings
menu”. 

This is where all the environmental values should be applied for use
in various device applications. Only the Velocity of Sound (V.O.S)
will apply for a Sonar application.

V.O.S.  –  System  value  applied  to  all  acoustic  devices  to  correct
plotter ranges. Applies to Sonar and Profiler and can also be applied
in MicronNav calculations.

Density, Latitude, Loc Gravity and Barometer can all be ignored for Hammerhead systems.
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16.10. Load/Save Settings

This is where the screen configuration can be saved and previously saved configurations can
be loaded. This is accessed via the Settings menu on the Menu bar.

Place the mouse pointer over the Load Settings menu item, to bring up a sub-menu listing all
the previously stored configuration settings.

There is a default setting that will always appear in the list and cannot be deleted. This is the
setting to be used for reverting the system back to factory defaults.

In addition to the factory default up to 8 different configurations can be saved. To save the
current  application  and  form layout,  click  on  the  Save  Config  button.  A prompt  will  be
displayed to enter the configuration name, with a default name of "User x" initially given,
where "x" is the configuration number.

Click on OK to store the current settings to file, where they can later be loaded using the Load
Settings. Disused configurations can also be deleted from the Save Configuration form by
highlighting the configuration to be deleted and then selecting Delete Config.

16.11. Log Function

This is accessed via the Log menu on the Menu bar:

With Logging de-activated, click on Play to replay a Log file or click Record to start recording
a new Log file. When a new Log file is opened for recording, the file name will default to a
Date and Time format.

During  recording,  the  Play  feature  will  be  locked  out  and  Record  option  will  be  ticked,
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highlighting  a  recording  is  active.  During  recording  the  status  bar  (on  the  bottom of  the
display) indicates the current log file size. Clicking on Stop or de-selecting Record will halt
recording.

During log file playback, the file details will be displayed in the replay dialog. The Pause
button temporarily halts the log file and Continuous Loop plays it continuously. There is also a
(clock) button to select play back at real time speed. The slider bar controls the replay speed.

Note

The name of the log file is displayed in the replay dialog caption bar.

Setup allows the directory where log files are to be stored to be changed and set a maximum
file size selected. The time-stamping of saved records can be in either Local or UTC time.

There is an Auto LogOn option to allow auto logging as soon as the system starts. There is a
check-box to activate this (On/Off) via the Rat 'F7' button.

The user can specify a Base Name or choose a Date/Time format to prefix the automatically
generated file names.
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16.12.  Print Function

This is accessed by navigating to the File menu and selecting Print

Quick Print On – when printing the Print Setup dialog box will not appear and default printer
and its settings are chosen.

Setup Printer – Select and setup the Windows Printer.

To Printer – Print to Windows Printer. When Quick Print On is set to.

Off,  a  setup  dialog  will  appear  allowing the  user  to  select  printer  and set  options  before
printing.

Caution

Printing may take a few moments during which sonar updates are suspended. It is
therefore  not  advisable  to  make  printouts  during  actual  underwater  operations
unless it is safe to do so.

16.13. GPS Display

This is accessed via the GPS in the Utilities menu.  When enabled the GPS dialog will be
displayed:

 Latitude or Easting

 Longitude or Northing

 Zone

 Course Over Ground

 Speed Over Ground

 Heading

 GPS Input – used to select and configure the GPS input

 Diagnostics – flashes green when there is an incoming signal

The GPS Setup panel is accessed by clicking on the “GPS Input” button and is where the
NMEA 0183 message type can be selected.

All  position  data  updates  displayed in  the  GPS panel  will  be  recorded when the  logging
function is used to record device data and GPS data.

0672-SOM-00001, Issue: 04 Page 40 of 90 © Tritech International Ltd.



SeaKing Site Survey System

The  GPS  Setup  panel  contains  4
drop-down  menus  for  selecting
NMEA  0183  message  types  for
Latitude/Longitude,  COG/SOG,
Heading and System Time.

It is possible to set the system time
via  any  of  the  listed  NMEA
messages  and  this  will  update  the

clock within the sensor device. This is used to time synchronise output data strings to a survey
computer or if log data containing both device and GPS position data is to be post-processed.

The  GPS  Setup  panel  includes  the  option  to  convert  and  display  the  incoming  Lat/Lon
positions in Easting/Northing format using a UTM or OSGB conversion. There is also facility
to select the particular Ellipsoid to apply in the UTM

conversion equation with option to apply a geodetic datum shift. By ticking the UserDefined
Datum Shift check-box, an Edit button will appear:

Clicking  on  this  button  will  display  the  User  Defined
Geodetic Shift panel where parameters can be entered for
the required datum shift.

Once  parameters  have  been
entered, press Return to go back
to the previous setup panel.

A terminal window can also be opened to display the incoming GPS data strings. This is
opened by clicking on GPS Diagnostic in the Utilities menu. 

The terminal window will appear as follows:
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16.14. Aux Device Display

This is accessed via the Utilities menu by clicking on Auxiliary Device.

When enabled, a pop-up Text Box form will be displayed. This can be used to display ASCII
character  data  from  a  serial  device  up  to  a  maximum  of  100  characters  in  length  and
terminated with a <Carriage Return><Line Feed> (ASCII code 13 followed by code 10).

The Aux Device form can process and display altitude data (in metres), received through a
surface  COM port,  from a PA or  NMEA Altimeter;  Digiquartz  pressure data  will  also be
converted  to  display  a  depth  in  metres.  The  values  entered  into  the  Environment  dialog
(accessed through the Settings menu) for density,  barometer and local gravity will  also be
applied to the calculation of depth.

• Use As Remote Event to send the Aux device data to the Sidescan Sonar or Sub-
Bottom Profiler plotter as a ‘Remote Event’ for annotation.

• View Raw Data to view the raw data string from known devices such as a PA Altimeter
or Digiquartz instead of the Seanet processed string.

All data updates displayed in the Aux Device text panel will be recorded when the logging
function is used to record device data.

The Diagnostic Led flashes green when there is an incoming Aux packet. A Terminal window
can also be opened to display the incoming data strings. This is opened from the Utilities menu
by selecting Auxiliary Device Diagnostic.
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17. Application Tools

The Application Tools menu can be accessed by right-clicking on the sonar display or by
selecting the Application Tools icon:  

17.1. Cursor

Adds the cursor position panel to the sonar display.

The  Polar  Check  box  changes  the  output  display  co-
ordinates from Polar (Range & Bearing) format if enabled
to Cartesian (X, Y) format if unchecked.

17.2. Markers

Adds A and B markers onto the sonar display, the range and
bearing to each marker,  separation and relative bearing are
shown.

Click on the symbol to deploy on the “Marker” panel and that
marker symbol will be dropped at the origin (0,0) on the sonar display.  Then, pick up the
marker using the left mouse button and drag it to the position required.

When both markers are dropped on the display, a line will
be  drawn  which  connects  them.   The  Delta  Range  and
Bearing at the bottom of the panel indicates separation and
angle between both markers.

There are 4 sets of markers that can be implemented.

17.3. Acoustic Zoom

“True Sonar Zoom” mode draws a zoom
box  on  the  display  positioned  by  the
cursor.  The sonar will take more samples
in  the  area  of  the  zoom  box  for  target
magnification.

“Zoom  Setup”  sets  the  size  and
magnification factor of the zoom box.

The size shows the screen zoomed area (red outline) as a percentage of the Acoustic Zoom
display window.  The Factor shows the number of zoomed range bins for each normal range
bin.  For instance, a Factor of 4 will take four times the number of samples in the zoomed area.
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17.4. Zoom Setup

Allows the Acoustic Zoom to be configured by selecting a
zoom factor or percentage size increase.

17.5. Position

Used to move and size the Sonar PPI display in its display window.

Centre X/Y – Adjust X & Y centre position of the display

Radius – Size of the display.

17.6. Display

Sets up the sonar display options.

DispMax  –  Tick  to  expand  sonar  display
vertically  to  fit  the  window.   If  un-ticked  will
expand horizontally.

RngLab – Switch the Range Labels On/Off

Rng Cross,  Rings  On,  Rings,  Grid  On –  all  of
these overlay different features on the display.

Sector On, Sector – Display a sector overlay with left and right angular limit adjustment (in
degrees).

Rotation – Rotational offset to correct sonar heading.

0672-SOM-00001, Issue: 04 Page 44 of 90 © Tritech International Ltd.



SeaKing Site Survey System

17.7. Installation

This configures the location of the sonar in the real world and enables the Geo-referencing of
sonar targets on the sonar display.

From Fixed 
Position

If there is no GPS input, select this option and input the Sonar position in
Latitude  and Longitude  co-ordinates  (DegMin  or  DegMinSec  format).  A
Heading input will also be applied, else a zero degree heading is applied. If
present it is also possible to set the fixed position from the USBL or GPS
input  so  that  they  can  be  disconnected  and  the  position  will  remain
persistent – simply click the appropriate button “Set Fixed from GPS” or
“Set Fixed From USBL”

From GPS 
Position Updates

If a GPS input is active, select this option. A Heading input will also need to
be active for the Geo-referencing to be functional. 

From USBL 
Position Updates

 If a USBL input is active, select this option. A Heading input will also need
to be active for the Geo-referencing to be functional. From Marker Positions
This function requires an application with Sonar and Nav displays loaded
(e.g.,   by selecting Settings→Applications→Sonar Nav). The chart of the
Nav display is used to obtain the Marker position references to be used in
this function. If a Nav chart is not used then the Marker positions must be
manually entered in the Sonar display.

Offset (GPS Rx 
to Sonar)

X and Y position offsets should be entered if there is any offset between
GPS receiver and Sonar (e.g. for a ship hull mounted system). Or, for an
ROV mounted  sonar,  if  the  GPS position  updates  are  the  position  of  a
sub/vehicle  then  this  offset  may  apply  for  the  separation  between  a
beacon/transponder and the sonar.

Heading Use this option to select the source of the heading data. If using a sonar
which contains an internal heading and compass device or if the compass is
connected to the Aux port of the sonar select Internal/Aux Compass. If the
compass device has been connected through a COM port on the SCU or PC,
or if a USBL system is in use then select Ship/USBL Compass. If the sonar
is mounted to an ROV and both the ROV and support vessel have a compass
it is possible to switch to ROV compass by selecting Sub/ROV Compass.

Once position and heading data are present, the Cursor display will be extended to provide
position co-ordinates when the mouse cursor is moved around the sonar plotter.
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17.8. Setup

8  Bit  –  Usually  checked.  Selects  the  intensity
sampling of sonar data (4-bit or 8-bit).

No Sens – Must  be off  (grayed out  as shown) for
normal use to synchronise angular head alignment.

Invert – Swaps the display from left to right. Enable
if mounted with Sonar boot down.

Detects – Paint the leading edge of strong targets on the screen (only applicable to certain
models of sonar).

Scrn Lock – Locks the number of range bins sampled to the screen resolution.

Flyback – Sets the sector scan to flyback instead of scan back. Normally off.

Xmit Off – This option is not available under normal operation. It is a diagnostics level tool
that will switch off the Sonar transmitter for test purposes.

Auto Dynamic Range – This will auto adjust the Display Contrast and Sensitivity whilst the
Sonar is scanning. Auto adjustment occurs at the end of each full sonar scan.

Lockout – Sets a minimum range for the Detects (always in metres).

Bins – This is the number of samples taken over the current scan-line.

Units – Select the display range units. Options are Metres, Feet, Fathoms & Yards.

17.9. Interpolate

Applies interpolation between adjacent samples on the Sonar display.
Blends out contrast and ‘blockiness’ on lower ranges and resolutions.

17.10. Aux Compass

Selecting Aux Compass will place
a  compass  and  pitch/roll  display
on  the  sonar  screen.  The  data
which  is  displayed is  taken from
the  device  selected  in  the
Installation dialog.
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Note

The compass and pitch/roll display are never displayed side-by-side as shown here, 
their position is at the top/bottom right of the screen by default but can be changed 
using the Compass Settings dialog.

17.11. Compass Settings

The  Compass  Settings  dialog  allows
configuration  of  the  compass  and
pitch/ roll sensor display on the main
screen.  The  position  can  be  selected
only if Auto

Positioning  is  first  de-selected.  Also
colour  and  opacity  can  be  controlled
through this dialog.

If more than one sensor is available for
selection this  should be performed in
the Installation dialog.

If  an  offset  is  required  it  can  be  entered  here  and  the  compass  can  be  corrected  for
displacement of magnetic against True North.

17.12. Overlay

When enabled, this option can be used to place and size an
overlay shape or outline onto the Sonar display canvas.

Style – Select the type of shape from; Circle,  Rectangle.
Triangle.

Size – Set the Width and Height of the shape.

Pos – Move the Shape with X, Y position offset from display origin.

Line Width – Change the line width.

Centre On – Enable centre marker (+) for the shape.
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18. Installing the Sonar Image Tiler Software

The installer file for the Sonar Image Tiler can be found on the Tritech Software Installation
CD or downloaded from: www.tritech.co.uk 

The installation CD will auto-run on disc insertion (if auto-run has been disabled launch the
“run.exe” program from the root of the CD).

First select the the “Seanet Pro” button to open the correct section:

Next, select the “Sonar Image Tiler” button to begin the software installation:

Note

If installing from the Internet an executable file called “ImageTilerSetup.exe” will 
be downloaded.  Run this file and follow the on-screen instructions.

0672-SOM-00001, Issue: 04 Page 48 of 90 © Tritech International Ltd.

http://www.tritech.co.uk/


SeaKing Site Survey System

19.  Sonar Image Tiler Software Functions

19.1.  Toolbar

 Import chart

 Export as image

 Save project

 Load project

 Clear project

 Add tile

 Delete all tiles

 Reset all tiles

 Resize tile

 Create mosaic

 Save mosaic

 Zoom in

 Fit to screen

 Zoom out

 Toggle coordinates dialog

 Toggle coordinate system dialog

 Toggle tile list dialog

 Toggle chart

 Show markers

 Move marker

 Pan tool

 Erase tool

 Area erase tool

 Remove tile background

 Export area
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19.2. Project Controls

19.2.1. Import/Create Chart

 

For  creating  a  blank  chart  or  importing  a  previously  created  chart.   For  more
information on this function please see 20.2. Create the Background Chart 

19.2.2. Export as Image

 

If an area is selected this button will export the selected area.  If no area is selected 
the whole chart will be exported.

Note

The markers will be embedded into the image file and if the image is
loaded  again  it  will  no  longer  be  able  to  modify  or  hide  them.  If
exporting the image to use again as a chart the markers should first be
hidden (see 19.14. Using Markers).

19.2.3. Save Project

 

The first time this is pressed it opens a dialog to name and then save the current 
state of the chart, tiles and markers as an XML file. Using this option allows the 
project to be loaded later and the markers or tiles moved or hidden.

Subsequent presses of the button will not prompt for a filename and instead save 
over the existing project – to save under a different name navigate to the File menu 
and select Save Project As....

Note

If the tiles have been moved or rotated away from their original positions
it will no longer be possible to restore them after the Project has been
saved, i.e.,  the new "original" position which they will  be returned to
when they are "reset" will be the position which they were in when the
Save Project button was pressed.

19.2.4. Load Project

 

For loading a previously saved Project file.  The files are  only generated by the
Sonar Image Tiler and are in XML format.

For details of the supported file format please refer to: 21.3. Project Files.

19.2.5. Clear Project

 

Removes any loaded data and clears the workspace.  Any unsaved data will be lost.
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19.3. Tile Controls

19.3.1. Add Tile

 

Opens a dialog to load an image tile. Image tiles must be in the correct format and 
have an associated world file.

For details of the supported file format please refer to: 21.1.  For Loading Tiles.

19.3.2. Delete All Tiles

 

Removes all the tiles from the chart.  Any unsaved changes will be lost.

To delete an individual tile right-click on it in the “Tile List” dialog.

19.3.3. Reset All Tiles

 

Resets all the tiles using the position, orientation and size from when they were first
loaded.  If the tiles were loaded as part of a project then they will be reset to the 
original state that they were when the project was saved.

To reset a tile individually, right click on it in the “Tile List” dialog.

19.3.4. Resize Tile

 

Tiles can be resized individually using this tool. When the tool is enabled each tile
will show a thin red outline with anchors at the corners and side midpoints. The
mouse pointer will change to arrows indicating the available resize direction when it
is positioned above the resize points. Click, hold and drag to resize the tile. The
corner anchors maintain aspect ratio while it is resized whereas the side anchors
allow the image to be stretched.

19.3.5. Create Mosaic

 

This will stitch all the visible tiles together into a single image. If only some of the
tiles are to be included the remaining ones should be hidden from view using the
Tile List as detailed in 19.13. Tile List Dialog

19.3.6. Save Mosaic

 

Saves  the  newly created  mosaic  as  an  image with  an  accompanying  world  file
which can then be loaded as a tile for future Projects.

Using the Save Mosaic function has the advantage over Create Mosaic in that it
does not alter the tiles within the project so they can still be modified if desired. The
newly created mosaic is in a completely separate file.
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19.4. Zoom Controls

The zoom controls allow the user to Zoom In on an area of the screen by using the button 
or by scrolling the mouse wheel forward.

Similarly, zooming out can be accomplished using the Zoom Out button   or scrolling the
mouse wheel backwards.

The view can be reset so the chart fits into the window by pressing the Fit To Screen button 

19.5. View/Hide Controls

These controls are the same as those found in the View menu and allow the different dialogs to
be shown or hidden from the workspace.

The background chart can be hidden to allow better viewing of the individual tiles by selecting
the View/Hide Chart button: 

For more detail on the functionality of the dialogs refer to  19.12.  Information Dialogs and
19.13. Tile List Dialog.

19.6. Marker Controls

Using these buttons the markers can be shown, hidden or moved. For a full description of the
use of markers see 19.14. Using Markers

19.7. Tile Manipulation Controls

19.7.1. Pan Tool

 

The pan tool is the default operation and allows the current viewpoint to be moved
around by clicking and holding the left mouse button – useful if zoomed in or using
a very large chart.

When this tool is selected and the mouse pointer is hovered over the tile handles the
functionality will change to that of move a single tile or rotate the tile (depending on
where the mouse pointer is located).

This does not alter the position of the chart – it simply changes the visible portion
on the screen.
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19.7.2. Erase Tool

 

Note

This action cannot be undone.  To restore the original tile, the tile has to
be deleted and then added afresh.

This tool allows parts of the sonar tile to be removed manually as if using an eraser.
To remove a section of sonar tile select this tool then click and drag the left mouse
button  over  the  desired  area.  When this  tool  is  active  the  mouse  cursor  should
change to an eraser. 

If multiple tiles are overlapping the erase tool will work on the uppermost tile only
but if a portion is already erased the eraser will start to erase the tile below as well.
To avoid accidentally erasing the wrong tile, it is recommended that the tiles that are
not being worked on are disabled or hidden using the Tile List (see 19.13. Tile List
Dialog)

19.7.3. Area Erase Tool

 

Note

This action cannot be undone.  To restore the original tile, the tile has to
be deleted and then added afresh.

To control the amount of sonar data displayed in a tile the automatic background
removal  tool  uses  an  intelligent  algorithm to  determine  unwanted  sections  and
remove them from the tile. Unwanted background pieces are those that are typically
around the edge of  the sonar  scan and do not  add any detail  to  the images.  In
general, acoustic shadows around areas of high intensity should be kept as they add
detail and context to the image.

19.8. Image Export Controls

 

The Image Export Area selection tool enables restricted areas of the workspace to
be exported to an image file. The mouse pointer will change to a cross-hair for more
accurate selection. To use, simply draw a box around the area to be exported and
then press the Export As Image button: 

Note

Only when this button is enabled will the selection be used as the export
area, otherwise the entire chart will be used.
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19.9. Moving Tiles

The Pan Tool button has to be selected for this function to work.

When the mouse pointer is over the centre of the tile it will change to a hand icon.  HOld down
the mouse button to drag the tile and position it correctly.

19.10. Rotating tiles.

The Pan Tool button has to be selected for this function to work.

A tile  can be rotated  by selecting  and moving the  rotation  lever  (see  below).  The mouse
pointer will change to show a hand with rotation arrows when it is positioned above the end of
the lever. Holding the mouse button down and dragging in a circular motion will rotate the tile:

→

The amount of rotation will be displayed in the Tile List panel (which can be displayed using
the View menu and selecting “Tile List”).

The colour of the rotate handle can be changed by navigating to the Tools menu and selecting
Options.
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19.11. Create a Mosaic of Tiles

To create a mosaic of tiles it will be necessary to have multiple tiles together within a single
geographic region. It will not be possible to create a mosaic if the tiles are very far apart, likely
as  a  result  of  having  an  incorrect  or  corrupt  world  file  which  results  in  their  incorrect
placement.

Creating a mosaic is a simple process, first arrange the tiles as desired and hide tiles that are
not going to be included in the final mosaic, then press the mosaic button on the toolbar 
which will start the mosaicking process. 

Note

The mosaicking process is irreversible and will result in a new tile created which
cannot be split into the original tiles. To restore the original tiles they will have to
be re-loaded.

→

Note

If “Save Mosaic” is pressed instead the output will not be on the screen but to a file
so a file chooser dialog will present itself.
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19.12. Information Dialogs

There are also three information panels accessible from the toolbar or the View menu: the tile
list; mouse position; and the coordinate system used. Both the tile list and the mouse view
display the position of tile centres or mouse pointer, respectively, using the selected coordinate
system.

19.12.1. Coordinate System

The Coordinate System display can be viewed and controlled by selecting the button  or
using the View menu and select Coordinate System option.

This allows the user to choose between using Decimal Degree, Degrees and Decimal Minutes,
Degrees, Minutes and Seconds and Universal Transverse Mercator (UTM). Selecting one of
these options automatically updates the display in the both the Mouse Position and Tile List
display panels.

19.12.2. Mouse Coordinates

The  Mouse  Coordinates  display is  also  controlled  from the  View menu  and View button
collection . It shows the mouse position in the context of the chosen coordinate system.

19.13. Tile List Dialog

The Tile List panel can be made visible using the “View” menu and selecting the “Tile List”
option.

Alternatively the Tile List can also be viewed using the button: 

Action on Multiple Tiles

By holding down the shift key on the keyboard it is possible to select multiple tiles
in the Tile List and move them up/down the layers together, show/hide them as a
group or delete/reset multiple tiles in one go.

Saving the tile will only work on one tile at a time.

19.13.1.  Layering Tiles

Layering the tiles determines the order in which they are displayed, i.e., tile 1 is displayed in
front of tile 2. The order can be changed by moving tiles up and down in this list, either as
individual tiles or in groups.
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Note

If centre marks or rotation handles obscure one another interaction will occur using
the lowest numbered (corresponding to the topmost) tile so it may be necessary to
re-order the tiles to gain access to the handles. 

Click on the row containing a tile to highlight it and then press either the UP or DOWN arrow
to bring the image forward or backward on the display by one layer.

Multiple tiles can be moved in one go by selecting each one and holding down the control key
on the keyboard (or by selecting a span using the shift key). Once selected the tiles can be
dragged as a group by holding down the mouse button and moving up or down the list to re-
order them.

The  tiles  will  be  automatically  renumbered  with  the  lowest  number  being  the  first  one
displayed.

The tiles can also be controlled using a menu that is accessible by clicking on the tile entry in
the list with the right mouse button. Using this method the tile can also be moved immediately
to the front or the back of the display stack.

19.13.2. Save Selected Tile

 

Saving a tile will export it with a new world file so that any changes that have been
made to the position or orientation can be preserved.

19.13.3. Delete Selected Tile

 

Deleting a tile will permanently remove it from the display. Any changes made to it 
will be lost.

If multiple tiles are selected when this button is pressed they will all be deleted.

19.13.4. Reset Selected Tile

 

Resetting a tile changes the tile location, orientation and size to the coordinates and
rotation value contained in the world file that was originally used to load the tile. 

Any subsequent movements or rotations that have been made are lost. If multiple
tiles are selected when this button is pressed they will all be reset.

Note

If a project has been loaded the tile will be reset to the orientation when the
project was loaded.  Saving the chart  and tiles as a project removes the
original tile data so to restore the original tile delete it and reload it.
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19.13.5. Show/Hide Selected Tiles

Tiles are hidden by de-selecting the check box to the left of the tile number.

If multiple tiles are selected when this button is pressed they will all be shown/hidden.

19.14. Using Markers

The Image Tiler has the ability to import a marker file which has been saved from Seanet Pro
(marker files have the extension ".mrk") or from a CSV text file (full details of the marker files
are in Appendix G, Marker Files).

First create the marker file from the chart in the MicronNav application in Seanet Pro. Then
open the marker file by navigating to Import Marker File from the Tools menu.

The imported markers will overlay the chart:

The positions of the markers is shown next to the location. Markers can be hidden using the
button on the toolbar: .

To move a marker first select the move marker button ( ) and then click on the marker and
drag it to the new location.

Note

If markers are displayed and Export as Image is selected they will be merged with
the background. If the chart is to be used again it will not be possible to move or
remove the markers. For this functionality the chart should be saved without the
markers or with them hidden. If Save Project is selected the chart, tiles and markers
are all saved as individual entities and can be interacted with as normal. 
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20. Using Sonar Image Tiler to Create a Mosaic

A mosaic as shown above can be created with the Sonar Image Tiler using a background chart,
and sonar image tiles with their associated world files. The user must first set a background to
place the image tiles. This background is called a "chart"; although if an actual survey chart is
not available a blank canvas can be used. There is also the option to use the first added tile as a
reference. All image tiles and background chart or blank canvas require geo-referencing. This
is  done during the creation of  the chart  by entering Position Co-ordinates  for the top-left
corner and a chart Width and Height.

With a background chart in place the sonar image tiles can then be loaded and any position or
rotation corrections made. The entire chart and tiles, or a selected area, can be exported as an
image file and a (separate) world file. This chapter is organised into sections explaining the
process of creating a mosaic, the tools available to the user, and also exporting an image or
saving the project.

Note

“Load Project” allows a previously created chart, collection of tiles and markers to
be loaded for further editing or for selecting an area to be exported as a bitmap.

20.1. Overview of Process

Prior to starting the mosaic process it is necessary to obtain the following:

• An image  with  GPS data  in  an  associated  world  file  to  use  as  a  background.  Or
appropriate GPS coordinates and geographical dimensions sufficient to encompass all
of the sonar image tiles if creating the chart manually.
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• A set  of  sonar  image  tiles  from a  Seanet  Pro  session  which  include  GPS data  in
accompanying world files.

Given data already created using Seanet Pro the process for tiling images into a mosaic is as
follows:

1. Create a chart:  either from an image, import a previously created chart  or create a
blank chart from GPS data.

2. Load sonar image tiles onto the chart.

3. Manipulate the image tiles to the correct position (if required).

4. Either export the resulting mosaic as a bitmap (with world data) or save as a project
(containing a chart and a collection of tiles) to work on again later.

20.2. Create the Background Chart

The Sonar Image Tiler starts with a blank screen:

First create a chart background onto which the sonar image tiles will be placed. If Seanet Pro
is running on the PC and has a chart configured as part of its Nav application then you can
select it using the Files menu and Open Seanet Chart option. If no Seanet chart is available
click on the Import/Create Chart button to set up a new chart background.
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Note

It is also possible to use the first tile as the chart background – see below for the
procedure for adding tiles. This tile cannot be moved or rotated and acts as the
fixed reference point for other tiles.

In the Add Chart dialog box there are three options for adding or creating a chart. The user can
select to use an image with associated world file; an image with manually entered position and
scale; or a blank chart with manually entered position data. These options are explained further
in the following sections.

20.2.1. Image with World File

Select Import World File for the Open World File dialog and select the appropriate world file.
The format  of  the  world  file  can  be  either  .bpw (bitmap),  .jgw (jpeg),  .tfw (tiff)  or  .wld
(generic/CAD).

The world file format for x and y co-ordinates can either
be  in  Easting/Northing  (E/  N)  or  Longitude/Latitude
(L/L). If co-ordinates are in E/N then a Zone will need to
be  entered  and  a  reference  Ellipsoid  selected  (for
definition of latitude, longitude and elevation).

Verify chart parameters are correct and click “OK” to confirm and load this chart.
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20.2.2. Image with Manual Positional Data

First, select Open Image button to bring up the Open Chart dialog and select the required chart
image. The image format can either be .bmp (bitmap), .jpg (jpeg) or .tif (tiff).

Note

Where an associated world file (matching name) is detected in the same folder as
the selected image the chart parameters will automatically be loaded.

Next,  enter  the  Point  of  Origin  co-ordinates  and  the  chart  Dimensions.  If  the  Universal
Transverse Mercator (UTM) coordinate system is used a reference Ellipsoid will also have to
be selected at this point (the default is WGS84 (World Geodetic System 1984)).

20.2.3. Create a Blank Chart

Select Use Blank to create a blank image for the chart background. A default width and height
will be set.
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The Point of Origin co-ordinates and the chart Dimensions will have to be set. If UTM then
also select a reference Ellipsoid at this point (the default is WGS84).

20.2.4. Chart Coordinate System

When creating charts the Point of Origin co-ordinates will be in the format that is currently
selected in the Coordinate System panel.  To change this select Cancel and navigate to the
Coordinate System control (if this is not visible go to the View menu and select Coordinate
System).

20.3. Add Image Tiles

Once the chart background has been loaded sonar image tiles can be added. Tiles must be
within the same geographic area of the chart background. 

Either click on the Add Tile icon, or add the tile through the “Tools” menu and “Add Tile”
option.
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• A dialog enabling searching and adding of images is shown. The images can be in
.bmp (bitmap), .jpg (jpeg) or .tif (tiff) formats. A matching world file is required in the
same folder or the image will not load.

• The tile will be added on top of the chart if the geographic co-ordinates are within the
background area.

• Simply repeat these steps to add further tiles.

Note

Several files can be added at the same time by holding down the Ctrl key whilst
selecting the images.

20.4. Manipulating Image Tiles

The  position  information  for  tiles  is  dependent  on  the  settings  when  the  tile  scans  were
created. 

If the imported position is incorrect the tiles can be repositioned on the chart at any point after
they have been added to provide a  more accurate  mosaic.  There are  several  repositioning
functions available: moving, rotating, and resizing. As well as tools to alter the appearance of
shadows in tiles: automatic cropping of unwanted shadows, manual eraser, and area erase.

For full details of the possible ways to manipulate the tiles please refer to  19. Sonar Image
Tiler Software Functions.

20.5. Save the Project

Save Project allows the chart to be saved as a chart and a collection of tiles (and any markers)
so it can be loaded for editing at a later date. The user is prompted for a file name, with the file
type being XML.

20.6. Exporting the Completed Mosaic as an Image

Charts can either be exported whole or areas can be selected and saved. To export the entire
image simply select Export as Image from the Files menu. This will then display a dialog
prompting  for  the  desired  location  and name of  the  file.  This  output  image will  have  an
associated  world  file  so  it  can  be  imported  into  other  software  packages  with  the  geo-
referencing intact.
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Note

If there is an area selected on the chart, clicking Export as Image will only save
what is contained within the selection region. The format of the saved chart will
depend on the format of the input chart (i.e., a .bmp input will generate a .bmp
output).

To create an output image using the Selection Tool follow these steps: 

1. Click on the Image Export Area button.

2. Using the left mouse button click and hold anywhere on the chart and then drag the
cursor across the screen to create a selection area.

3. Click on the Files menu and go to Export as Image. Enter a filename and select the
desired file type (.jpeg, .bmp or .tiff) then click Save. A world file will be created with
the same filename as the image file.

Note

There will also be a .kmz file created. This is a Google Earth file format and will
allow the image to be viewed in Google Earth.

Selection area within dotted line

→

Output image

Note

It is also possible to output just the tiles (i.e.,  without the background chart) by
clicking on the Save Mosaic button: 
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21. Sonar Image Tiler Supported File Formats

21.1.  For Loading Tiles

In order to correctly position the images each image tile file should be accompanied by an
equivalent "world file" which contains positional data. This data should come from a GPS
linked into Seanet Pro. If a GPS is available Seanet Pro will automatically create a world file
with the correct data when a Snapshot is taken. 

The following file formats are supported:

Image Type World File

.bmp .bpw

.jpeg/.jpg .jgw

.tiff/.tif .tfw

.png .pgw

Note

The image file and world file should have the same filename (i.e., sonar.bmp and
sonar.bpw).

The image tiles have to be saved from the latest version of Seanet Pro; if an older
version is used they will not open in the Sonar Image Tiler. If in doubt, remove the
current  version  of  Seanet  Pro  and  either  download  the  latest  version  from
www.tritech.co.uk or re-install from the CD-ROM which contained the Image Tiler
installation program.

21.2. Saving Images or Mosaics

Saving an image can either be the whole chart (with any visible tiles or markers), a marked out
section or a mosaic of tiles either way the supported formats are:

.bmp Bitmap image

.kmz Google Earth format

.png Portable Network Graphic

Note

The Sonar Image Tiler will create a matching world file for the image.
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21.3. Project Files

The Sonar Image Tiler uses a customised XML format for saving and loading projects. These
project files will preserve any tile data or marker data so that they can be manipulated again at
a later stage or transferred to another computer for editing.

Note

Due to the fact that the project files contain the data for all the tiles, if the project
has many tiles it can result in the production of large XML files.

21.4. Marker Files

Two different marker file types are supported,  both of which are in CSV format but with
different filename extensions and different complexity.

.mrk Seanet Pro full length marker files

.csv A shortened version of the Seanet Pro format

Note

For full details of the marker file formats please see Appendix G. Marker Files.
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22. Maintenance of the Hardware

22.1. After each use of the equipment

Make sure that after using the sonar head that it is washed down with fresh water and check
the unit for any signs of obvious damage.

Pay particular attention to the transducer head and free any organic matter which has become
trapped. Once the unit is clean; dry thoroughly and place in the storage container.

If the optional MicronNav Transponder is fitted to the top of the Hammerhead tripod it should
be removed from its mounting bracket and both the bracket and the Transponder should be
washed thoroughly with fresh water prior to being dried and stowed.

The tripod is made out of stainless steel which will corrode if left in prolonged contact with
salt water so it is essential to wash the tripod thoroughly with fresh water and make sure it is
completely dry (the tripod is free-flooding so it is advisable to flush fresh water through the
pole sections). When drying attention should be given to any places where moisture is likely to
collect, such as the joins between leg sections.

22.2. Regular Maintenance

There  are  no  user  serviceable  parts  inside  the  Hammerhead  Sonar,  Interface  Box  or
MicronNav System and it is not necessary to take them apart for any maintenance tasks.

The tripod should be inspected for any signs of corrosion and the threaded sections of the legs
should be treated on a regular basis with an appropriate grease. 

The cable on the reel is jacketed with polyurethane and is resistant to corrosion but a regular
inspection routine should be established to ensure that the length of cable does not contain any
damage (which may occur if snagged or caught on underwater debris).

If the system is in regular use, or submerged routinely for extended periods, it is advisable to
arrange for an annual service to be carried out by Tritech International Ltd. This service will
enable the equipment to be checked thoroughly or for any worn parts to be replaced and will
enable long-term trouble free operation of the SeaKing Site Survey System. For details of the
servicing options available contact Tritech International Ltd (see Help & Support for contact
details).

0672-SOM-00001, Issue: 04 Page 68 of 90 © Tritech International Ltd.



SeaKing Site Survey System

23. Storage of Equipment

If storing the equipment for extended periods make sure that it is completely dry (if necessary
leave to air-dry before stowing).

Pack into storage containers along with several pouches of silica gel. The original packing
containers  contain  specific  foam  cut-outs  for  the  storage  of  the  equipment  so  wherever
possible they should be re-used. The foam will absorb moisture so if the cases are allowed to
get wet they should be dried thoroughly prior to stowing equipment in them.

Attention should be given to drying the tripod which is free-flooding so will likely contain
moisture inside the steel tubing.

The cable is jacketed with polyurethane which is resistant to corrosion but if it is intended to
store the reel for an extended period without use then it is advisable to reel out the cable and
dry its entire length. This will also give the opportunity to inspect the cable for any damage
which has occurred during use.
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24. Troubleshooting

The following chapter outlines some problems which can readily be fixed by altering settings
or other simple procedures. If any of these solutions do not solve the problem please contact
Tritech International Ltd using the contact details listed in Help & Support at the start of this
manual.

No World File created by Seanet Pro

Likely caused by a lack of GPS/USBL data.

If using a GPS/USBL ensure that they are connected and set up properly

Check the Installation page to make sure that the correct positioning device is being selected,
or that Fixed Position is selected.

Snapshot captures entire Seanet Pro screen

Incorrect registry setting.

Modify the Windows registry using regedit.exe to ensure that the following setting is applied:

HKEY_CURRENT_USER\Software\System Technologies\SeaNet\ScrnCapSonarOnly = 1

Sonar scan is sluggish or stops moving, but communication link is fine

Entanglement of head with debris, ropes, weeds, etc.

1. Turn off power to the sonar to prevent motor damage

2. Retrieve the tripod or ROV, free the sonar head and examine for any obvious signs of
damage

3. Test in air before redeployment

Image appears stretched, distorted or of low range

Hammerhead not sitting level.

1. Check the attitude sensor reading to determine the sonar head level
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2. Lift tripod or re-orientate ROV to ensure correct placement and levelling of the sonar

3. If  necessary move to a new location to clear  any debris  or uneven features of the
seabed

Continuous "No Comms" message displayed on the Seanet Pro status bar

Communication failure or cable failure.

1. Check power is turned on

2. Check cabling from Hammerhead Interface Box to the PC

3. Ensure power is reaching the unit by checking LED's are lit

4. Retrieve sonar from water and ensure that all cabling is correctly installed and has no
splits  or  ruptures – if  necessary remove cable from waterblock to  check for water
ingress (also check any blanked waterblocks)

Sonar display does not show compass or attitude control and shows many types of 
device options under Applications menu

The Seanet Pro software in use is the generic version or a previously installed version (i.e., not
the one included on the Hammerhead installer CD-ROM)

1. Launch regedit.exe from the Windows Start menu

2. Navigate to the System Technologies tab found under Software

3. Locate the Seanet tag and alter the CmdLine so that it contains the value -H

4. Restart Seanet Pro and connect to the Hammerhead device

5. The compass can also be displayed or hidden by right-clicking the main sonar screen
and selecting Auxiliary Compass

No Internal Compass Heading/Pitch/Roll data is being displayed

Auxiliary Compass not selected or wrong compass selected in Sonar Tools menu, Installation
page.

1. Right-click on the sonar display and select Auxiliary Compass
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2. Navigate to the Installation page from the Sonar Tools menu and select Internal/Aux
Compass. Note that the Ship/USBL Compass will display data from any connected
MicronNav system or  from an external  compass  string  received  through a  surface
COM Port as configured in Utilities menu and Com Setup

3. If the above steps do not correct the problem close Seanet Pro and open the Seanet
Setup application. The Hammerhead device should be detected and listed as Node 2.
To access the setup for this click on Action and then Setup to check that the compass
settings are correct.

Displaying the output from more than one sonar on the Seanet Pro screen

Installation of the Seanet Pro application from the Hammerhead CD-ROM will result in it
loading into  a  special  mode  where  it  only displays  one  sonar  by default  –  shown in  the
Applications menu as Single Sonar

1. To display other Tritech International Ltd devices such as MicronNav, Profiler, Bathy,
Gemini  or  Video  it  will  be  necessary  to  create  new  display  applications.  This  is
achieved by selecting Application Wizard from the Applications menu and follow the
step-by-step instructions.

2. Other Seanet Pro compatible devices can be brought into Seanet Pro through another
communications link or they can be connected onto the same ARCNET network. The
Hammerhead will have to be configured manually for networking with ARCNET and
instructions can be found in the Appendices.

3. Other  device  data  from 3rd  parties  such  as  GPS,  Compass,  Altitude  can  be  input
through a surface COM Port. From the Utilities menu select Com Setup to configure
COM ports for these inputs.

No head is detected in the Seanet Setup application when running the Hammerhead 
with the Hammerhead Interface Box

Data cable or power supply problem

1. Check  for  either  red  or  green  LED's  illuminated  behind  the  viewport  area  on  the
Hammerhead. If no LED is illuminated check the power cables are correctly plugged
in  and  are  not  damaged.  Also  check  the  cables  between  the  Interface  Box  and
PC/laptop. Make sure that the Power button is turned on.

2. If the LED's are illuminated first check the USB cable is securely connected and then
make sure that the correct COM port is selected by navigating to Utilities and Com
Setup.
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No head is detected in Seanet Setup when running the Hammerhead on an ROV and 
connected to an SCU using ARCNET communications

Insufficient power or incorrect communications settings

1. First  check  that  the  red  or  green  LED  is  illuminated  and  if  not  remove  the
Hammerhead from the ROV and test on a short test lead. If the unit powers up on a
short lead, check the ROV cabling and that it can output at least 30W at 24V. Also
make sure that there is only a single yellow waterblock in use.

2. If power is reaching the unit then make sure the communications are set up properly.
Ensure that Seanet V2 or newer is installed on the SCU. Make sure that the termination
resistors and ARCNET network are set-up properly (see the Appendices for the correct
procedure)
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Appendix A. Example System Configurations

The Hammerhead unit is equally suited for use either on an ROV or deployed over the side of
a vessel or harbour using a tripod to sit on the sea floor. Since the unit is based on existing
Tritech International Ltd SeaKing technology it is relatively straightforward to integrate into
existing systems or create a mixed system. A couple of examples are presented here.

Note

It may be necessary to use a separate power supply if the auxiliary sonar is rated to
a different power rating.
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Appendix B. Assembly of Hammerhead Tripod

Step 1 – take the two half-shells and assemble them over the top of the Hammerhead.

Step 2 – Place the gimbal ring over the half-shells, rotate until the screw holes are lined up
then insert screws – note the location of the plastic washer.

Step 3 – Next take the tripod and assemble the legs, screwing them into the top plate – note
that the hook eyes are aligned so the clip can secure both together.
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Step 4 – Raise the tripod hook and open the Hammerhead securing lugs as shown, then insert
the  Hammerhead  up  through  the  top  plate,  rotate  and  rest  in  place  before  fastening  the
securing lugs.

Step 5 – Finally connect the cable and route as shown to prevent any snagging.
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Appendix C. Interface Box Installation and Operation

The Interface Box should be installed as follows:

1. Install the Seanet Pro software from the Hammerhead Installation CD-ROM

2. Plug in the USB lead from the computer to the Interface Box, it will be detected and
automatically installed and a new COM port should appear on the computer. Launch
Seanet Pro and ensure that this COM port is correctly configured and selected for use
with the Hammerhead.

3. Plug in the power supply for the interface box and turn the unit on.

4. Monitor the LEDs on the Interface Box to confirm power and communications are
normal, the sonar should start displaying in Seanet Pro in a few moments.

Warning

If operating on 240V AC mains supply (or equivalent from a generator) the 
Interface Box must not be exposed to water.

For reference, a copy of the label printed on the bottom of the Interface Box is shown below:
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Appendix D. CHIRP Signal Processing

There are several advantages of  Tritech International Ltd Digital  Sonar Technology (DST)
which allows the use of CHIRP signal processing technology in order to improve the images
generated by the sonar.

In monotonic (single frequency burst) sonar, the range resolution is determined by the length
of the transmitted pulse. The smaller the pulse is, the greater the resolution achievable and
vice-versa.  The  smallest  pulse  length  is  typically  50µs and  velocity  of  sound in  water  is
approximately 1500m·s-1 which gives a range resolution of 37.5mm. This result effectively
determines the ability to resolve separate targets.

Target  
Seperation 

T1

T2

Time

Transmitted Pulse

Target 1 echo

Target 2 echo

Sonar range 
resolution

Target  
seperation

Combined echo  
(seen by the receiver)

Using the example  above,  if  two targets  are  less  than  37.5mm apart  then  they cannot  be
distinguished from each other. The net effect is that the system will display a single large
target, rather than multiple smaller targets.

CHIRP signal processing overcomes these limitations by sweeping the frequency within the
burst over a broad range of frequencies throughout the duration of transmission pulse. This
creates a signature acoustic pulse – the sonar knows what was transmitted and when. Using
pattern-matching technology, it can now look for its own unique signature being echoed back
from targets.

Transmitted signal

Transmitter 
circuit

Receiver 
circuit

Received decoded signal

pulse duration

In a CHIRP system, the critical factor determining range resolution is now the bandwidth of 
the CHIRP pulse which means the range resolution is given by:

The bandwidth of a typical Tritech International Ltd CHIRP system is 50kHz
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With velocity of sound in water of 1500m·s-1 this gives a new range resolution of 15mm.

This time, when two acoustic echoes overlap, the signature CHIRP pulses do not merge into a 
single return. The frequency at each point of the pulse is different, and the sonar is able to 
resolve the two targets independently.

Target  
Seperation 

T1

T2

Time

Transmitted Pulse

Target 1 echo

Target 2 echo

Sonar range 
resolution

Target  
seperation

Combined echo 

Both targets  
are visible.

The response from the pattern-matching algorithms in the sonar means that the length of the
acoustic pulse no longer affects the amplitude of the echo on the sonar display.

Longer  transmissions  (and  operating  ranges)  can  be  achieved  without  a  loss  in  range
resolution.

Additionally CHIRP offers improvements in background noise rejection, as the sonar is only
looking for a swept frequency echo, and removes random noise or out-of-band noise.
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Appendix E.  ARCNET Termination

Depending  on  the  cable  length  the  ARCNET communication  link  requires  a  termination
resistor to be installed at each end of the umbilical cable. Normally this is supplied fitted
within the ARCNET cable DA-15 or within the SCU/SeaHub at the surface and is left for the
user to fit at the sub-sea end in a convenient junction box or by use of a special waterblock.

The purpose of these terminations is to attenuate any electrical interference or "reflections"
which may occur due to an impedance mismatch and the overall aim is to improve signal
quality and negate any effects which might otherwise be felt by other sources of impedance
such as from the cable itself.

The diagram below shows best practice to use when installing termination resistors on an
ARCNET network of Tritech International Ltd sonar products.

Note

A special  yellow  waterblock  is  available  from  Tritech  International  Ltd which
contains an in-line impedance of 39Ω which will enable quick and easy installation
of the subsea termination resistor.

Cable length Termination Baud rate setting

Less than 100m Single 39Ω subsea resistor Normal baud rate

100 – 1200m 270Ω at surface and 39Ω subsea Normal baud rate

1200 – 2500m 270Ω at surface and 39Ω subsea Half baud rate

Note

If there is more than one sensor connected then the subsea resistor should be fitted
at the Junction Box or splice of the cable.
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Appendix F. Networking and Communication

Overview

The sonar units fitted with the AutoComms feature enable automatic connection of a single
sonar device to a computer without the need to dis-assemble the unit in any way. The sonar
scans available comm settings until it finds an active one (the one which is connected to the
computer). Once an active one has been found it will set its communication protocols to the
correct settings to enable communication with the PC. The AutoComms feature does not work
for networked devices though and instead the following procedure should be adopted to allow
communication between the sonar heads and surface PC.

The basic procedure is:

1. Set the communication protocols of the surface unit to match the sonar (i.e. if the sonar
is communicating on RS232, set the surface unit to RS232)

2. Turn off AutoComms (if present)

3. Change the sonar settings to meet new requirements of the system – at which point it
will "disappear" from the computer

4. Repeat for all the sonar devices to be connected

5. Change the surface unit to match the new system settings

Manually Setting Comms

Note

Unless  it  has  been specified  differently at  time  of  purchase  the  factory default
settings of all Tritech International Ltd sonars are RS232 serial at 115200 baud so if
AutoComms has previously been disabled these settings could be tried first.

Set Surface Unit to Match Sonar

Launch the SeaNet Pro Setup application and then select the Setup option from the Action
column.
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A warning should appear to show that the settings are going to be changed, acknowledge this
and then select the appropriate setting from the dialog box which presents itself. The example
below shows the setting for port C of a SeaHub being changed to RS232 from RS485.

Set Sonar to New Setting

The sonar and SeaHub should both show a Status of OK and have green status colour. Once
they are both in this condition select the Setup action for the sonar but this time click on the
sonar which will then bring up the Digital Sonar Setup screen:
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First make sure that the Disable AutoComms option is checked and then change the Comms
Mode settings in the bottom right corner. If working on an ARCNET network the baud rates
should be changed by clicking on Baud Rates (in the bottom left of the above screenshot).
Serial baud rates are set up using the Channel Setup screen which is accessed by returning to
the main setup screen and navigating to Com Setup from the Utilities menu:

Note

Repeat the above procedures for all sonar devices on the network and then set the
surface control box to match the new communication protocols of the netwworked
devices.
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Hard Reset

To perform a "hard reset" and force the sonar back to factory settings first turn it off and then
put a strong magnet over the case in the location indicated below. Power the unit up with the
magnet held in place and factory settings should be restored.

SeaKing and Hammerhead
Measure 55mm from casing 

edge in-line with puller

SeaPrince
Place magnet over the 

mark on the casing
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Appendix G. Marker Files

Seanet Pro includes the facility to lay a series of markers to label and track objects, points of
interest and way positions. These markers can be saved to file for the purpose to re-load at a
later date, to form part of a report or for use with the Sonar Image Tiler program.

There are two formats of marker file:

1. A full, comma separated file format with the filename extension .mrk

2. A shortened, comma separated format with the filename extension .csv

Full Marker File Format (.mrk extension)

This  is  the  format  that  is  native  to  Seanet  Pro  and  includes  full  details  of  the  marker
configuration.  The file is in an ASCII Comma Separated format and contains the following
fields:

Index Value Description

1 ID This is a unique string ID. It comprises a 2 letter header ("mk")
followed  by  a  DateTime  code.  Any  unique  string  value  is
acceptable.

2 Group This is unused and should be set to 0.

3 X Coordinate For the .mrk file this will always be output in UTM Easting.

4 Y Coordinate For the .mrk file this will always be output in UTM Northing.

5 Altitude This is UTM Altitude and is currently unused.

6 UTM Zone Parallel Zone latitudinal letter (e.g. 'C' through 'X').

7 UTM Zone Meridian Zone longitudinal number (e.g 1 through 60).

8 UTM Ellipsoid Ellipsoid  code  (0  =  Airy,  1  =  Australian  National,  2  =
Bessel1841, 3 = Clarke 1866, 4 = Clarke 1880, 5 = Everest, 6
=  GRS80,  7  =  International  1924,  8  =  Modified  Airy,  9  =
WGS84).

9 Point Size Applies  to  Circle,  Square  &  Triangle  shape  types  only,
otherwise set to 0.

10 Date & Time Date & Time in English(GB) Locale. Format is "dd/mm/yyyy
hh:mm:ss"

11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4 =
Preset Image (see Image Info below).

12 Shape Colour Applies  to  Circle,  Square  and  Triangle  shape  types  only,
otherwise set to 00000000 (32 bit RGBA).

13 Font Inner Colour Applies to Comment Text (32 bit RGBA).
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Index Value Description

14 Font Outer Colour Applies to Comment Text (32 bit RGBA).

15 Marker Bitwise Bit 1 = Show Marker, Bit 2 = Show Coordinates, Bit 3 = Show
Comment Text (i.e. 00000111 = Show All).

16 Image Info Presets  =  Red  Flag,  Blue  Flag,  Green  Flag,  Buoy,  Anchor,
Rock, Danger, POI, ViewPort, Sonar, Diver, Wheel, Comment
or MLO Alternatively can be full path and name of an image
file (e.g., 'C:\Image1.bmp').

17 Comment Comment text.

For example, the following two markers would produce a two line .mrk file as shown:

Line 1 mk41149.5595988657,0,548699.614997778,6313221.96999907,-
5.3544902067987E-76,V,30,9,0,28/08/2012 
13:25:51,4,00000000,00FFFFFF,00000000,7,Red Flag,Possible Wreck Site

Line 2 mk41149.5605201736,0,548724.213265236,6313198.87994614,-
5.3544902067987E-76,V,30,9,0,28/08/2012 
13:27:48,4,00000000,00FFFFFF,00000000,7,Rock,WARNING! ROCKS

Shortened Marker File Format (.csv extension)

This file format is a more concise and usable format, particularly for loading a pre-defined
target list into Seanet Pro. The file is in an ASCII Comma Separated format and contains the
following fields:

0672-SOM-00001, Issue: 04 Page 86 of 90 © Tritech International Ltd.



SeaKing Site Survey System

Index Value Description

1 ID This is a unique string ID. It comprises a 2 letter header ("mk")
followed  by  a  DateTime  code.  Any  unique  string  value  is
acceptable.

3 X Coordinate For the .mrk file this will always be output in UTM Easting.

4 Y Coordinate For the .mrk file this will always be output in UTM Northing.

17 Comment Comment text.

11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4 = Preset
Image (see Image Info below).

16 Image Info Presets = Red Flag, Blue Flag, Green Flag, Buoy, Anchor, Rock,
Danger, POI, ViewPort, Sonar, Diver, Wheel, Comment or MLO
Alternatively can  be  full  path  and name of  an  image file  (e.g.,
'C:\Image1.bmp').

10 Date & Time Date  &  Time  in  English(GB)  Locale.  Format  is  "dd/mm/yyyy
hh:mm:ss"

For example, the following two markers would produce a two line .mrk file as shown:

Line 1 mk41149.5595988657,-2.1991799999203,56.9600300036883,Possible Wreck 
Site,4,Red Flag,28/08/2012 13:25:51

Line 2 mk41149.5605201736,-2.19877999992026,56.9598200036882,WARNING! 
ROCKS,4,Rock,28/08/2012 13:27:48
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Glossary

.bmp The standard filename extension for bitmap images.

.kml The standard filename extension for a Keyhole Markup Language file which 
contains georeferencing data. This file will either be incorporated within a 
.kmz file or requires an accompanying image file (with the same file name) to
be valid. Used by Google Earth.

.kmz The standard filename extension for a compressed file containing the 
Keyhole Markup Language file (.kml) and image file. For storing 
georeferencing data and images in a single file. Used by Google Earth.

.mrk The standard filename extension for marker files exported from Seanet Pro, 
saved as a text file in tabular format with table cells separated by commas.

.png The standard filename extension for Portable Network Graphics – a 
bitmapped image format employing lossless compression.

.tiff or .tif The standard filename extension for Tagged Image File Format.

AC Alternating Current

AIF Originally "Acoustic Interface" but also used to refer to "ARCNET Interface"
in which case it can refer to either the interface port on a SeaHub or SCU or 
to the expansion card available for installation into a computer.

ARCNET Attached Resource Computer NETwork – a network protocol similar to 
Ethernet but with the advantage of working over much longer ranges.

ASCII American Standard Code for Information Interchange – a character encoding 
scheme originally based on the English alphabet.

AutoComms Hardware developed by Tritech International Ltd for use in sonar heads 
which enables the sonar to automatically switch to the correct communication
protocol to match that of the surface controller.

CD-ROM Compact Disc Read Only Memory

COM Short for "communications". When used in the context of computers typically
it refers to the Microsoft Windows designation of a serial communications 
port (in this instance it may be given a number, "COM3", for example). In the
context of sonar hardware it can be used to refer to the circuit board that 
controls the communication to the surface. 

CSV Comma Separated Value – a text file in tabular format with table cells 
separated by commas, usually given the filename extension .csv but this can 
vary depending on the application.

DA-15 A 15 pin D shaped connector used mainly for the ARCNET connection on the
SCU and SeaHub.

DC Direct Current

Google Earth A virtual globe, map and geographical information program, originally called
EarthViewer 3D prior to being acquired by Google Inc. in 2004.

GPS Global Positioning System.
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Hammerhead A survey sonar produced by Tritech International Ltd and part of the SeaKing
range. Capable of producing very high resolution sonar images which can 
then be loaded into the Sonar Image Tiler software as part of a site survey.

JPEG or JPG Joint Photographics Expert Group – a compression method and file format 
for image files, files can be stored with either .jpeg or .jpg file extensions

Kevlar Poly-paraphenylene terephthalamide; high strength, light weight, material 
branded and sold as Kevlar by DuPont.

LAN Local Area Network

LED Light Emitting Diode

MicronNav An Ultra Short Baseline (USBL) system for location and tracking of ROVs, 
divers, etc. Consists of the MicronNav 100 surface control unit (similar to the
SeaHub but with different functionality) a "dunking transducer" which is 
mounted on the vessel/dockside under the waterline and a responder which is 
mounted on the ROV or Hammerhead tripod.

PA500 An altimeter sold by Tritech International Ltd

PC Personal Computer

RAT Remote Access Terminal – the detachable front part of the Tritech Surface 
Control Unit (SCU) computer. Provides an alternative to using a keyboard 
and mouse.

ROV Remotely Operated Vehicle

RS232 Traditional name for a series of standards for serial binary data control 
signals.

RS485 A standard for defining the electrical characteristics of drivers and receivers 
for use in a balanced digital multipoint system (also known as EIA-485).

RX Receive (data)

SCU Surface Control Unit – a specially manufactured computer which is rack 
mountable and capable of processing the data from the sonar equipment 
running either Windows XP Embedded or Windows 7 and Seanet Pro or 
Gemini software.

SeaHub An alternative to using a Seanet SCU, this device connects to a laptop or PC 
via USB interface, essentially this takes the signal from the sonar (in RS232, 
RS485 or ARCNET) and converts it into a signal suitable for the USB port of
the computer.

SeaKing A specific sonar produced by Tritech International Ltd but also refers to the 
family of sonar equipment manufactured by Tritech International Ltd 
comprising of the SeaKing, SeaKing DST scanning and profiling sonars and 
the Hammerhead survey sonar.

Seanet Pro The software supplied by Tritech International Ltd which is capable of 
running all the sonar devices. 

Sonar Image 
Tiler

The application developed by Tritech International Ltd to allow 
georeferenced sonar images to be joined together and placed on a chart as a 
mosaic.

Tritech The 4000m depth rated connector developed by Tritech International Ltd for 
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waterblock their subsea equipment. 

TX Transmit (data) 

USB Universal Serial Bus.

USBL Ultra Short Base Line (positioning system)

UTM Universal Transverse Mercator coordinate system – a 2-dimensional 
Cartesian coordinate system to give locations on the surface of the Earth.

WGS84 World Geodetic System (1984 revision) – a standard for use in cartography, 
geodesy and navigation and used as the reference coordinate system by GPS 
devices.

world file A file used by the Tritech Sonar Image Tiler program which is designed to 
accompany an image file and contains geo-referencing data. The file format 
will have different extensions depending on the format of the image file:

Image Type World File
.bmp .bpw
.jpeg/.jpg .jgw
.tiff/.tif .tfw
.png .pgw

XML Extensible Markup Language. A markup language and file format that is 
designed to be both human and machine readable.
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